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Getting Started with the MDS Manager 

Getting Started 
The MDS Manager is only available in ECS10.  The first time you open the Manager, you will 
need to clear out any old, incomplete assessments, as well as the backlog of MDS assessments 
that have previously been transmitted and accepted by CMS.  This will essentially create a 
“clean slate” for you to begin using the MDS Manager to track which assessments need to be 
transmitted to CMS and subsequently mark that they have been accepted. 

Opening the MDS Manager for the First Time 
1. Click American Data – ECS > Write > MDS 3.0 Assessment > MDS Manager or use an 

Easy Access button titled “MDS Manager” setup for this purpose.   

2. The Client Filter screen will be displayed.  It is designed to select the appropriate MDS 

records for you without manually selecting client names.   

o This will default to your currently selected site(s) and service(s). 

o There will be check marks in all status types except “Other.”  

o Making changes to the Status selections could cause you to miss assessments 

that are in progress or need to be transmitted. 

3. Click OK to accept the default filters. 

4. ECS will check when, if ever, the manager 

was opened before the selected site(s).  If it 

has been longer than 90 days, a message 

will appear: 

5. When you click OK, all completed 

assessments for the selected site(s) will be 

marked as Accepted.  This may take a few 

moments. 

6. The MDS Manager will load. 

MDS Manager Screen Description 
The Manager is made up of several menu options across the top, as well as four informational 
panels.   

• Progress Panel – Displays the total number of assessments that are currently being 

worked on.  The progress bar consists of three color coded categories: 

o Held (red) – the number of records that have been started but have not been 

completed. 

o Completed (yellow) – the number of records that have been completed but 

have not yet been batched (Transmission Count = 0). 
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o Transmitted (green) – the number of records that have been batched 

(Transmission Count > 0) but have not been marked as “Accepted” within the 

Manager. 

• Held Assessments Panel – Lists all the assessments that are currently in progress.  Menu 

options allow you to manage and work on these assessments as needed. 

o When the Manager is first opened, you may find old, unwanted records on the 

Held Assessments list, in addition to the ones you are currently working on.  Any 

unwanted assessments should be dealt with prior to using the Manager on a 

regular basis.   

• Transmit Manager Panel – By default, this lists all assessments that have been 

completed, but have not yet been marked as “Accepted.”   

o When the Manager is first opened, this panel will be blank.  It will begin to 

populate as records are completed.   

• Scheduling Tool Panel – By default, this lists all residents who have upcoming due 

OBRA assessments.   

o When the Manager is first opened, you may notice several residents populating 

into here that should not.  This would mean that they did not have a Discharge 

Assessment completed to “stop” their stay.  Currently, the only way to stop 

them from displaying would be to complete a Discharge MDS record.    

Removing Unwanted Records from the Held Assessments Panel 
Check for old, unwanted assessments that for some reason have never been completed, 
deleted, or marked as incomplete.  These should be removed before implementing the MDS 
Manager. 

1. The records are listed alphabetically by client.  Start by sorting the list into “Target 

Date” order.  To do this, click on the Target Date column heading.  Assessments 

without a date will be listed first, followed by the oldest assessments and ending with 

the most recent.   

2. Review the list for any assessments that should be removed.  This may include records 

for fake/practice clients, or any other records that for some reason were never 

completed.  Determine what should happen to each unwanted record.  Note that 

double clicking on a resident’s name displays his/her entire MDS history. 

a. Records for fake/practice clients can be deleted, or you can choose to move the 

fake client into the “Other” Locate status they do not appear on the MDS 

Manager at all.  Only American Data staff can move fake/practice clients into 

Other.  Please contact the Clinical Department so we may complete this task for 

you. 

Adding the MDS Manager to Easy Access 
The MDS Manager should be added as an Easy Access button to the MDS Coordinator’s Easy 
Access screen. 
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1. On the Toolbar, click onto the Setup icon. 

2. Find the location of the MDS Coordinator’s Access screen.  This will most likely be in a 

section called Clinical Access, or it may be in the MDS 3.0 section.   

3. Double click into the topic to display the words inside.  

4. Copy and past an existing access button and open the Word Properties. 

a. In the Options tab, rename the Short Name to be “MDS Manager.” 

b. In the Options tab, remove any Actions listed in the Actions area. 

c. In the Word Control tab, remove any topic listed in the GoTo Topics/Word area. 

d. In the Options tab, select the Add button to the right of the Actions box, click 

onto “Pick Menu.”  Open Write > MDS 3.0 Assessment, select MDS Manager, 

and click OK.  Change the “When to Run” option to “On Click” and click OK.   

e. Click OK to save setups for the MDS Manager access button. 

5. Move buttons around to position the MDS Manager button into the desired location. 

6. You may choose to delete some access buttons now, or later; that complete functions 

that may now be done via the MDS Manager.  Buttons which could be deleted include 

Start, Continue, Change, Delete, View, Transmit, Incomplete, and Restore.   
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About & Using the MDS Manager 

MDS Manager Access 

Rights 
The MDS Manager right is found in the rights tree at Write > MDS 3.0 Assessment > MDS 
Manager.  When a facility is converted from v9 to v10, User Group rights are automatically 
update for the MDS Manager as follows: any user group with full or partial rights to either 
Write > MDS 3.0 Assessment or View > MDS 3.0 Assessment will be updated with rights to the 
MDS Manager.  This setting can then manually be changed as needed.   
 
Within the MDS Manager, there are various buttons to complete MDS functions as well as 
Chat and Messaging functionality.  These buttons will only work for users if they have rights to 
the individual features as setup in the user group rights tree.  For example, the “Change” 
button will only function for a user who has rights to Write > MDS 3.0 Assessment > Change.  
In this way, a variety of users can be given access to the MDS Manager without raising 
concerns regarding their level of access.   

Opening the MDS Manager 
1. Click American Data – ECS > Write > MDS 3.0 Assessment > MDS Manager or use an 

Easy Access button titled “MDS Manager” setup for this purpose.   

2. The Client Filter screen will be displayed.  It is designed to select the appropriate MDS 

records for you without manually selecting client names.   

o This will default to your currently selected site(s) and service(s). 

o There will be check marks in all status types except “Other.”  

o Making changes to the Status selections could cause you to miss assessments 

that are in progress or need to be transmitted. 

3. Click OK to accept the default filters. 

4. ECS will check when, if ever, the manager 

was opened before the selected site(s).  If it 

has been longer than 90 days, a message 

will appear: 

5. When you click OK, all completed 

assessments for the selected site(s) will be 

marked as Accepted.  This may take a few 

moments. 

6. The MDS Manager will load. 

Use the Help Popup feature (the question mark in the top right corner [?]) for information 
about individual features.  Click onto the question mark, and then click onto the button or 
feature you want to learn more about.   
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MDS Manager Features 

MDS Manager Screen Description 
The MDS Manager is made up of several options across the top, as well as four informational 
panels (Progress Panel, Held Assessments Panel, Transmit Manager Panel, & Scheduling Tool 
Panel). 

• Setup – Controls which data panels are displayed when 

you use the Manager.  Each user can control this setting 

for themselves, and make changes as needed.  ECS 

remembers your most recent setting. 

• Message – Allows you to write an Internal Communication 

message to users that will appear in their Message list.   

• Chat – This opens the Chat box to allow you to 

communicate with other users currently logged into ECS. 

• IPA Predictor – Provides clinical decision support for IPA completion with precise 

feedback on whether and how much your facility will benefit regarding CMI and 

dollars. See supplemental IPA Tools handout for more information and detailed 

instructions. 

• IPA Forecast – Allows you to review resident data to determine who may qualify for an 

IPA. It displays the resident’s therapy and nursing function score for each day in the 

selected date range, based on caregiver documentation. See supplemental IPA Tools 

handout for more information and detailed instructions. 

• Names – Choose different names than the current selection.  Used for trouble-shooting 

specific names or situations. 

• Restore Names – If you used the “Names” button to select specific residents, the 

“Restore Names” button will revert the Manager back to the filter settings used when 

the Manager was opened. 

• Refresh – Clicking Refresh updates the Manager with changes to MDS assessments that 

were made since the previous refresh or since the Manager was loaded – whichever is 

more recent.  The last date and time the MDS Manager were refreshed will display to 

the right of Refresh.   

Progress Panel 

 
This displays the total number of assessments that are currently being worked on.  The 
progress bar consists of three-color coded categories, described below: 

• Held (red) – The number of records that have been started but have not been 

completed. 

• Completed (yellow) – The number of records that have been completed but have not 

been batched (Transmission Count = 0). 
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• Transmitted (green) – The number of records that have been batched (Transmission 

Count > 0) but have not been marked as “Accepted.” 

Held Assessments Panel 
This lists all the assessments that are currently in progress.  The menu options allow you to 
manage and work on these assessments as needed. 

 
Features 

• Click a column heading to sort the listed records by that column. 

• When records are deleted, marked as incomplete, or completed using the ‘Submit’ 

button on the Status screen of individual records, select the ‘Refresh’ button at the top 

of the Manager to remove those from the Held Assessments Panel. 

• When you have had the MDS Manager open for a while, you can view changes or 

progress to assessments by selecting the ‘Refresh’ button at the top of the Manager. 

• Double click a resident’s name to display the MDS history for that person. 

• The total number of records on the Held Assessment list corresponds to the red bar of 

the Progress Panel displayed above the Held Assessments Panel.   

• The completion date, V0200B2, and V0200C2 columns will display any predicted 

values in gray or red (if due in the next three days, or past due).  Once a date has been 

filled out on the MDS, it will display in black text.  The MDS coordinator may adjust 

these dates in the Held Assessments section by double clicking onto the date needing 

to be adjusted.  The user is then presented with a calendar to select the appropriate 

date.  If date(s) are adjusted manually directly in the Manager, the user’s initials will 

display behind the date.   

Menu Options 
• Start – Click Start to start a new MDS assessment for any client. 

• Continue – Select an assessment from the list and click Continue to open the 

assessment and continue work on it. 

• Delete – Select an assessment from the list and click Delete to remove the record. 

• View – Select an assessment from the list and click View to view the MDS. 

• Incomplete – Select an assessment from the list and click Incomplete to mark the 

record as incomplete.  You will be asked to enter a reason as to why it is being marked 

as incomplete. 

• Restore MDS – Click Restore MDS, select a client.  Choose a deleted or incomplete 

record from the list and restore to an active status.    
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• Filter – Click onto Filter to narrow down the assessments which are displayed in the 

Held Assessments Panel.  Options to select from include PPS, OBRA, Insurance (Med 

Replacement), Admissions, Scheduled (Quarterly/Annual), Discharges, IPA, and OSA.   

• Export – Click onto the Export button to export all data within the Held Assessments 

Panel.   

• Print – Click onto the Print button to print some of the key data within the Held 

Assessments Panel.   

Transmit Manager Panel 
By default, this panel lists all assessments that have been completed, but have not yet been 
marked as “Accepted.”  

 
Features 

• The Transmit Manager panel displays all the MDS records that are completed but have 

not yet been marked as accepted by CMS.  The Menu options listed right above this 

panel allow you to manage and work on the assessments as needed.   

• You can click on a column heading to sort the listed records by that column. 

• When records are deleted or marked as accepted by using the drop-down options in 

the Status column or the Accept All button, use the “Refresh” button at the top of the 

Manager to remove them from the Transmit Manager Panel. 

• The Transmit Date column displays the last possible transmission date for the 

assessment. This value will appear in gray unless it is coming up in the next three days, 

or it is overdue; in which case the date appears in red.  Once an assessment has been 

marked as "Accepted," the Transmit Date column clears out and displays a dash (-). 

• The Status column is used to track the progress of batched assessments.  You may 

mark assessments as Accepted, Rejected, or Resubmitted using the drop-down list.  

When an assessment has been marked as Accepted, it will no longer be displayed 

once the screen is reloaded or refreshed, unless you use Filter to display accepted 

records.   

• Double click a resident’s name to display the MDS history for that person. 

• The total number of records on the Transmit Manager list corresponds to the total of 

the yellow and green bars of the Progress Panel displayed above the Held 

Assessments panel.  The yellow completed assessments are the total number of 

records that have a transmission count of zero (0).  The green Transmitted records are 

the total number of records with a transmission count greater than zero, but that have 
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not been marked as Accepted.  The combined total of completed and transmitted 

records is equal to the total number of records listed in the Transmit Manager panel. 

Menu Options 
• Change – Select an assessment from the list and click Change to open the assessment 

via “Change Assessment” mode.  This would be utilized to adjust assessments that 

have been submitted into ECS but rejected by CMS.  Or to adjust an MDS prior to 

batching it into a transmission file.   

• Correct – Select an assessment from the list and click onto Correct to create a 

correction record for that assessment.   

• Delete – Select an assessment from the list and click Delete to remove the record. 

• View – Select an assessment from the list and click View to view the MDS. 

• Transmit – Click Transmit to open the Electronic Transmission screen and create a 

batch file.  You do not select assessments from the list prior to clicking onto Transmit. 

• Filter - The Filter button’s primary purpose is a trouble-

shooting feature.  It allows you to display records for a 

certain date range, lets you display Accepted 

assessments which are not listed by default, and lets 

you filter for any combination of completed, held, 

rejected, and resubmitted assessments.  Example: You 

would like to see the past 12 months of MDS records 

for a specific resident: 

o Use the Names button at the top of the Manager to select just the resident you 

are investigating.  The Manager will refresh to display only that resident. 

o Click Filter.  Use the check boxes to select what type of assessments you wish to 

see.  In this case, make sure there are check marks in all four check boxes. 

o Click Start Date to select a start date for the assessments you wish to view.  

Selecting a date 12 months ago will display any assessments with target dates 

that fall in the period between the target date and the current date. 

o Click OK to display the matching records. 

o When you are done reviewing the records, make sure you select Filter again to 

remove the “Show Accepted” filter. 

o You may select ‘Restore Names’ at the top of the Manager to return to the usual 

display. 

• Accept All - You can use the Accept All button any time you wish to mark all the listed 

assessments as accepted.  The user will be prompted through a couple of questions to 

click OK, Yes, No, or Cancel on.   

• Export – Click onto the Export button to export all data within the Transmit Manager 

Panel.   

• Print – Click onto the Print button to print some of the key data within the Transmit 

Manager Panel.   
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Scheduling Tool Panel 
 
The Scheduling Tool panel assists users in determining when a resident’s next OBRA MDS is 
due.   

 
 
Features 

• The Scheduling Tool panel displays the next OBRA MDS that is due as well as the next 

assessment’s predicted target date.  Any dates displaying in red indicate that the target 

date is coming due in the next few days or is already past due.   

• You can click on a column heading to sort the listed records by that column. 

• The other columns available in the Scheduling Tool will list the days since the resident’s 

last quarterly MDS, last full MDS, as well as the last OBRA that they have marked as 

either Accepted, Submitted, or still in progress (Held).   

• Double click a resident’s name to display the MDS history for that person. 

Menu Options 
• Start - To start an MDS, click onto the name, and select Start.  This will open the Type of 

Assessment/Tracking screen with the OBRA type already pre-selected.  Verify the 

information and click OK to begin the MDS.   

• End Date - If only wanting to see MDS’ due prior to a specific date, click onto End Date, 

select the date, and click OK.  Click onto End Date again to clear out the date.   

• Export – Click onto the Export button to export all data within the Scheduling Tool 

Panel.   

• Print – Click onto the Print button to print all data within the Scheduling Tool Panel.  

 
 
 


